AVALANCHE MC: CREATING
wavelink REGIONS AND DSERVER
This document provides L O C AT I O N S

information about
creating regions, dServe . . . . . . . .
reating regt rver This document provides instructions for creating regions and dServer Locations and then deploying
locations, and dServer dServers to the dServer Locations in Avalanche MC. It is intended to serve as a quick start guide for this
process only. For detailed information about regions, dServer Locations, or other tasks in Avalanche

deployment packages. MC, refer to the latest version of the Wavelink Avalanche Mobility Center User Guide.

The following steps overview the processes detailed in this document:

OVERVIEW 1. Create a region.

This document contains 2. Create a dServer Location.

the following sections: 3. Move the dServer Location to the region.

. Managing Regions 4. Build a dServer deployment package

*  Managing Locations 5. Deploy the dServer package to the dServer Location.

* Creating dServer When you complete these steps, in the order presented, the result will be a functional dServer deployed
Locations to a dServer Location with a specified region.

. Building dServer

Deployment NOTE: This document is current as of Avalanche MC version 4.4.

Packages
. Deploying dServers

. Revision History

MANAGING REGIONS

As a basic organizational component, regions provide an orderly way to control and organize your
dServer Locations. From the Navigation Window of the Avalanche MC Console, you can see at a glance
the way in which your regions and dServer Locations are arranged and grouped. By organizing your
regions and dServer locations by similar characteristics, such as geographic location, you can create
profiles and settings on a per-region basis. When you apply the profiles to a region, all dServer locations
within the region can receive those settings.

You can create regions at the My Enterprise level or you can create nested regions: regions within
regions. This expands flexibility and allows you to further group and organize your dServer Locations
for tighter network control. You can add as many regions to the Avalanche MC Console as necessary to
manage your wireless network effectively.

This section provides instructions for the following tasks:
. Creating Regions
. Creating Nested Regions

CREATING REGIONS

You can add any number of regions to the Avalanche MC Console to manage your wireless network
effectively.

To create a region:

1. Right-click My Enterprise and select New Region.

2. Inthe New Region dialog box, type the name of the new region and click OK.
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The new region appears in the Navigation Window.

CREATING NESTED REGIONS

A nested region is a region that is placed within another region and appears a step below that region in
the Navigation Window of the Avalanche MC Console. Nested regions provide flexibility when setting
up your network and console structure. You can apply network, alert, and Mobile Device dServer and
Infrastructure dServer profiles appropriately to each region.

For detailed information about the way nested regions and profiles interact, refer to chapter six of the
Wavelink Avalanche Mobility Center User Guide or the Managing Regions topic in the online help file
included in the Avalanche MC software.

To create a nested region:

1. Right-click the region in which you want to place the nested region and select New Region.
2. Inthe New Region dialog box, type the name of the new region and click OK.

The new region appears a step below the selected region in the Navigation Window.

MANAGING LOCATIONS

A dServer Location is another organizational component of Avalanche MC. The dServer Location
represents any location that contains a dServer. A dServer is comprised of software that manages the
wireless components such as mobile devices or access points. The dServer Location can be a unique
physical entity, such as a warehouse in another country, or a subsection of an entity, such as the third
floor of an office building.

A dServer Location is not operational until you deploy the dServer software to it. In most cases, the
location you want to manage does not contain a dServer. As a result, you must create a new dServer
Location in the Avalanche MC Console specifying where you want the dServer Location to be, and then
deploy one or more deployment packages containing the dServer software to that location. Until the
dServer deployment package is sent, dServer Locations appear as just another level of organization in
the Navigation Window with no functionality.

There are two types of dServers that you can deploy to a dServer Location, Infrastructure dServers and
Mobile Device dServers. Each dServer Location can have up to one Mobile Device dServer and one
Infrastructure dServer residing on it.

To ensure that all wireless devices are managed at a particular dServer Location, you can do one of the
following:

. Configure your network hardware to allow Infrastructure and mobile device broadcasts to reach
the dServers.

. Use the dServer Location-based tools included with Mobile Manager to configure the dServer to
manage multiple subnets.

. Segment the location into multiple dServer Locations by installing the appropriate dServers at
each subnet.

This section provides information about the following topics:
. Overview of dServer Placement
. Creating dServer Locations
. Moving dServer Locations to Regions

OVERVIEW OF DSERVER PLACEMENT

The ability to manage your wireless network depends on dServers being able to locate and communicate
with your devices. Currently, there are two primary methods of installing dServers: centralized and
distributed.
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Centralized dServer Installation

In centralized dServer installations, a single dServer is responsible for managing all of the infrastructure
and mobile devices on the network. Centralized dServer installations are typically found in
environments where specific dServer Locations within a network might be unable to support their own
dServers. An example of this environment is a collection of retail stores. While the headquarters for
these stores can support a dServer, it might not be feasible for each individual store to have its own
dServer. In this case, installing the dServer centrally is an ideal solution.

[ Avalache MC

e @ Conzole, Enterprize
S Server and Local
d=erver

N >
-, 3 1

A Centralized Installation of dServers (Simplified)

If you determine that a centralized dServer installation is the best choice for your wireless network, it is
important to remember the following:

. You must know the network subnets to configure the dServer to listen for infrastructure
broadcasts.

. You must know what switches and routers reside between the dServer and infrastructure devices.
(This is particularly helpful should any troubleshooting be necessary.)

. You must have a general understanding of the overall performance of the wireless network, to
ensure that specific time-based features (such as WEP key rotation) are configured correctly.

Distributed dServer Installation

In distributed installations, a dServer resides on each network subnet. These dServers are responsible for
managing on a per-subnet basis. Often, distributed dServer installations of Avalanche MC are found in
environments where wireless network uptime is critical to business operations. For example, if a
company has multiple locations across the country, connectivity between each dServer Location might
depend on factors outside the company control—such as weather, the performance of third-party
services, and so on. In these situations, installing a dServer on each subnet provides a more robust
environment in which wireless network downtime is minimized.

If you determine that a distributed installation is the best choice for your wireless network, it is important
to remember the following:

. Because you are installing multiple dServers on multiple systems, it might take more time to
completely install and optimize Avalanche MC for your network.
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. You must ensure that when you upgrade Avalanche MC, you upgrade all dServers across the
network.
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A Distributed Installation of dServers (Simplified)

If the location already contains one or more dServers, you do not need to create a new dServer Location.
However, you must ensure that the dServer installed at the dServer Location is compatible with the
Avalanche MC Console. Refer to the installation requirements located in the Wavelink Avalanche
Mobility Center User Guide for more information.

CREATING DSERVER LOCATIONS
Before you deploy a dServer (mobile device or infrastructure) to a dServer Location, you must create a

dServer Location and add information about the dServer Location in the console. When you create a
new dServer Location, you give the dServer Location a name and identify the IP address and location.

You need the following information to create a dServer Location:
. The IP address of the system that will contain the dServer Location.

. The user name, password and domain for the system that will contain the dServer. The user
name and password must have administrative access to the system.

. Access to and the location of a shared folder on the system that will contain the dServer
To add a dServer Location:

1. From the File menu, select New > New dServer Location.
The Enter dServer Location Name dialog box appears.

2. Type the name of the dServer Location in the dServer Location Name text box and click Next.
The Enter dServer Location IP Address dialog box appears.

3. Type the IP address of the system which contains (or will contain) a dServer in the dServer
Location IP address text box and click Next.

The Enter dServer Location City Name dialog box appears.
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4. Type the name of the city where the dServer Location resides in the dServer Location City Name
text box.

Avalanche MC will search its database to find all cities that have the name you specified. If you
do not want Avalanche MC to search its database, enable the Check here to bypass this search
checkbox.

NOTE: Avalanche MC connects to a database at the Wavelink Corporation Web site.

5.  Click Next.
The Choose dServer Location dialog box appears.

6. Select the appropriate city from the Search Results list and click Next.
The Select Time Zone dialog box appears.

7. Select the time zone for the city and click Next.
The Enter dServer Location Login Information dialog box appears.

8. Type the User Name, Password, and Domain for the system on which the dServer resides (or
will reside) and click Next.

NOTE: This user name and password must have administrative access to the system.

The Select Shared Folder Location dialog box appears.

9. Select the appropriate location for the shared folder.

NOTE: If the Enter Shared Folder Information dialog box appears, type the name of the shared folder
where Avalanche MC updates are installed in the Share Name text box.

Type the directory path where Avalanche MC updates are installed on this remote system in the Share
Path text box. This path is not the network path (such as \\systeml\deploy\), but is the local path to
the shared folder (such as c:\deploy\).

NOTE: Any user that will be deploying to the dServer Location must have security access to the shared
folder specified. If a user that does not have security access to the shared folder, any deployments will
fail.

10. Click Next.
Avalanche MC attempts to contact the dServer Location to verify that all the information is
correct. After a few moments, the Connection Results dialog box appears and displays if a
connection was established to the dServers.

11. Click Next.
The dServer Location Created dialog box appears.

12. Click Finish.

The dServer Location appears in the region in which you created it. You can assign the dServer
Location to a different region, deploy dServers to the dServer Location or modify the dServer
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Location.

MOVING DSERVER LOCATIONS TO REGIONS

When you create regions, you assign dServer Locations to that region. One of the benefits of creating
regions is that when you change region configuration settings, those changes can be applied to all
dServer Locations assigned to that region. Before you can really manage anything at the dServer
Location level, that dServer Location must belong to a region.

To move a dServer Location to a region:

. Right-click a region and select New dServer Location.

NOTE: When you use this method, you will be prompted to create a new dServer Location that will
automatically be assigned to that selected region.

-Or-

. Right-click a dServer Location in the Unassigned dServer Locations folder, select Move dServer
Location To from the menu that appears, and select the region.

The dServer Location moves to the selected region and you can begin managing your mobile
devices.

BUILDING DSERVER DEPLOYME NT PACKAGES

Your dServers are not functional until you create and deploy dserver deployment packages. A
deployment package is a collection of files that define dServer behavior for both Infrastructure and
Mobile Device dServers. You must create these packages so you can control your dServer Locations,
thereby controlling your network infrastructure and mobile devices.

When you create a combined deployment package for both infrastructure and mobile devices,
Avalanche MC deploys a full-function Infrastructure dServer and a full-function Mobile Device dServer to
a dServer Location that may or may not have dServers already.

When you create a deployment package for Infrastructure dServers, Avalanche MC deploys a full-
function Infrastructure dServer to a dServer Location that may or may not yet have an Infrastructure
dServer. To create an Infrastructure dServer deployment package you must have an at least one user
configured with administrative privileges and a password.

To create a deployment package for all devices:

1.  From the Tools menu, select Deployment Packages.
The Deployment Package Manager dialog box appears.

2. Click Add.
The Select Package Type dialog box appears.

3. Select the Create a dServer Package option and click Next.
The Select Server Type dialog box appears.

4. Select the type of dServer deployment package you want to create and click Next.

. Select Combined Infrastructure and Mobile Unit dServers if you want to build and deploy
both an Infrastructure and Mobile Device dServer.

. Select Infrastructure Only if you want to build and deploy an Infrastructure dServer only.
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. Select Light-weight Infrastructure Updates to update the firmware of an already deployed
Infrastructure dServer. For more information refer to chapter six in the Wavelink Avalanche
Mobility Center User Guide.

. Select Mobile Device dServer if you want to build and deploy a Mobile Device dServer only.
The Enterprise dServer Location dialog box appears.

5. Type the IP address of the Enterprise Server and click Next.
The /nstallation Path dialog box appears.

6. Type the full path where the package is to be installed on the remote system in the /nstallation
Path dialog box, for example: C:\Program Files\Wavelink.

If you want to include the RAPI gateway in this deployment package, enable the Include RAPI
Gateway option. Click Next.

NOTE: If you are creating a Mobile Device dServer deployment package only, skip to step 11. Steps 7 - 10
apply to Infrastructure dServer deployment packages only.

The Select Infrastructure dServer Options dialog box appears.

7. Determine how the Infrastructure dServer selects a network adapter and click Next.

. If you want the dServer to select the first available network adapter, select the Use First
Available option.

. If you want the dServer to select an adapter based on a specific subnet, select the Select by
Subnet option and then type the subnet address in the text box.
8. Determine the security options for the dServer and click Next.

. If you want the dServer to operate without any security measures, select the No Security
option.

. If you want the dServer to require a user name and password, select the Security without
Encryption option.

. If you want the dServer to require a user name and password and encrypt communications
between management consoles and the dServer, select the Security with Encryption
option.

The Select Infrastructure Firmware Support dialog box appears. This dialog box contains a col-
lection of folders. Each folder represents a specific type of infrastructure device.

9. If you only want to select from firmware bundled with Avalanche MC, enable the Only show
available firmware binaries included on server.

NOTE: When you enable the Only show available firmware binaries included on server option, you will
be able to select firmware that is bundled with Avalanche MC and will deploy to the Infrastructure
dServer.

If you do not enable this option, you will see a list of all firmware support including firmware options
that are not bundled with Avalanche MC. For more information, refer to the latest version of the
Wavelink Avalanche Mobility Center User Guide.

10. Select the firmware versions this dServer supports.
To select firmware, open the appropriate folder within the dialog box. A list of available firmware
versions appears. Select a firmware version by enabling the checkbox next to the firmware name.

You can select any number of firmware versions from each folder.

The Enter Package Name dialog box appears.
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11. Type a name for the package in the Package Name text box and click Next.

Avalanche MC creates the deployment package. When it is finished, the Package Complete
dialog box appears.

Click Finish to return to the Deployment Package Manager dialog box.
12. You can now create a new package, edit a package, or delete a package as needed.
13. Click Close to return to the Avalanche MC Console.

To deploy the dServer package, you must use the Task Scheduler.

DEPLOYING DSERVERS

After you create one or more deployment packages and add one or more dServer Locations to the
Avalanche MC Console, you can deploy the dServer software using the Task Scheduler. Deploying a
dServer is defined as sending a deployment package to a specific location within your network.

You send a deployment package to a location by scheduling an event within the Task Scheduler. An
event is an action during which Avalanche MC sends information to or receives information from a given
location.

This section describes how to send a deployment package to a location on your network, resulting in the
creation of a new dServer that you can manage with the Avalanche MC Console.

Before you can successfully deploy, ensure you specify the user under the security tab of the shared
folder to which you are deploying.

NOTE: Any user that will be deploying to the dServer Location must have security access to the shared
folder specified. If a user that does not have security access to the shared folder, any deployments will
fail.

To deploy a dServer Location:

1. Ifyou have not already done so, create a deployment package.

2. From the Tools menu, select Task Scheduler.
The Task Schedule dialog box appears.

3. Click Add.
The Select A Task dialog box appears.

4. Select Deploy/Update Distributed Servers from the Task Type list and click Next.
The Select Task Destination dialog box appears.

5. Select the region or dServer Location by enabling the checkbox next to the region or dServer
Location name. You can also select all regions by clicking All.

6. Click Next.
The Select Server Package to Deploy dialog box appears.

7. Select a dServer package and click Next.
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NOTE: If you have not created a deployment package, you can do so at this time by clicking the Open
Deployment Package Manager link at the bottom of the dialog box.

The Select Scheduling Options dialog box appears.
8. Determine when the event will occur and click Next.

9. Select one of the following options:
. If you want the event to occur immediately, select the Perform the task now option.

. If you want the event to occur at some point in the future, select the Schedule a one-time
event for the task option.

If you selected the Schedule a one-time event for this task option, the Schedule the Time
Window dialog box appears.

10. Select the start date and time for the event.

11. Determine when you want the event to end.

. If you want the event to end only after the deployment is complete, select the Run until
complete option.

. If you want the event to end after a specified amount of time, select the End by option and
then select the end date and time for the event. If the event is not finished by this date and
time, Avalanche MC will generate an alert.

NOTE: Once Avalanche MC begins to send data to a dServer Location, it does not stop until all data is
sent. This prevents a dServer Location from receiving only part of the information it needs. When an
event’s end time is reached, Avalanche MC completes any deployments that are in-progress, but does
not start sending data to any of the remaining dServer Locations.

12. If you want the start and end time for this event to be based on the local time for the dServer
Location, enable the Use dServer Location’s Local Time option. Otherwise, the start and end
times are based on the local time for the Avalanche MC Console.

13. Click Next.

The Review Your Task dialog box appears.

14. Review your the task to ensure that it is correct and click Next.

The Task Scheduled dialog box appears.

15. Click Next to schedule a new event, or click Finish to return to the 7ask Schedule dialog box.

The task is added to the Scheduled and Recurring Tasks list. The task will run according to its
schedule, and once it has completed, it will move to the Successfully Completed Tasks list.

NOTE: If you want to run the task manually, select the task and click Run Task.

Once you have completed deploying your dServers, you can create and deploy as many as are
necessary to manage your network. For more information about the tasks and functions you can
perform using Avalanche MC, refer to the latest version of the Wavelink Avalanche Mobility Center User
Guide which is located on the Wavelink Web site. For other questions, please contact Wavelink
Customer Service at 888.699.WAVE (9283) ext.2.
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